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Sample PowerPoint Presentations on the Web 
• Davis School District – http://www.davis.k12.ut.us/district/etc/powerpoint.html 

Finding Presentations on the Web 
• Open the Internet and go to http://www.google.com 
• Click on Advanced Search.  
• Enter words or phrases to describe desired results. 
• On the File Format line, click on the down arrow 

and choose Microsoft PowerPoint (.ppt). 
• Click on the Google Search button at the top. 

Using PowerPoint Presentations on the Web 

Playing a PowerPoint Presentation 
• Navigate to the PowerPoint presentation. 
• Click on the link. 
• Click on the Open button. 

Saving a PowerPoint Presentation 
• Navigate to the PowerPoint presentation. 
• Click on the link. 
• Click on the Save button. 
• Navigate to the location where the presentation is to be saved. 
• Notice the name of the presentation and change if desired. 
• Click on the Save button. 

Starting PowerPoint 
• On the Start button, click on All Programs þ Microsoft 

PowerPoint. 

Opening a Presentation 

Using the Menu Bar 
• On the Menu Bar, click on File þOpen  

o OR click on the Open button. 
• Choose the name of the file and click OK. 

Using the Task Pane 
• Click on the down arrow at the top of the Task Pane and choose New Presentation. 
• Under the Open a presentation section, click on More presentations…. 
• Navigate to the location of the desired presentation. 
• Click on the desired presentation. 
• Click on the Open button. 

http://www.davis.k12.ut.us/district/etc/etclessons.html
http://www.google.com


 

The Office Assistant 

Showing the Office Assistant 
• On the Menu Bar, click on Help þ Show Office Assistant. 

Changing the Office Assistant 
• Right click on the Office Assistant. 
• Select Choose Assistant ... 
• Click on the Next button to find the desired Assistant. 
• Click on OK. 

Using the Office Assistant 
• Click on the Office Assistant. 
• Enter a question in the balloon. 
• Press the Enter key.  
• Choose the most appropriate answer from the list. 
• A window will open on the right side with the instructions. 
• You can follow the instructions in the main document window while the 

instructions are still showing on the right. 

Closing the Help Window 
• Click on the X in the top right corner of the window. 

Closing the Office Assistant 
• Right click on the Office Assistant and choose Hide. 

Understanding the PowerPoint Window 

Menu Bar 

Seeing the Full Menu 
• On the Menu Bar, click on Tools þ Customize and choose the Options tab. 
• Click to place a check mark in front of Always show full menus. 
• Click on the Close button. 
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Toolbars 

Choosing Toolbars  
• On the Menu Bar, click on View º Toolbars. 
• Click in the box to select the toolbars you want. 
• Toolbars that are already showing have a checkmark by them. 

 
 
   
   

 
 
 
 
 

Seeing all the Toolbar Items 
 On the Menu Bar, click on Tools  Customize and click on the Options tab. 
 Click to place a checkmark in front of Show Standard and Formatting toolbars 

on two rows. 
 Click on the Close button. 

Outline and Slides Pane 
• On the left side is the Outline and Slides Pane. 
• The Outline tab displays an outline of the 

presentation.  
o Text can be entered directly into the outline. 

• The Slide tab shows thumbnails of each slide. 
o Click on the desired slide to display it in the 

Slide Pane. 
• Click on the X at the top right corner of the pane to 

close it. 
• To bring the pane back, on the Menu Bar, click on 

View and choose Normal (Restore Panes). 

Slide Pane 
• In the middle of the screen is the Slide Pane. 
• This is the working area most people use. 

Notes Pane 
• At the bottom is the Notes Pane. 
• Notes for the presenter can be entered in the Notes Pane.   
• Notes are associated with the slide that is showing. 
• Note – The notes do not show up when viewing the slide show. There is an option to print the notes. 

Changing the Size of the Panes 
• Place the cursor over the line that divides the panes. (The cursor changes to a two-headed arrow.) 
• Click and drag to the desired size. 
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Changing the View 
• The view of the window can be changed with buttons at the bottom of the Outline and Slides Pane 
• OR on the Menu Bar, click on View. 

Button Name Description 

  Normal View Click on this button to see the three panes. 

 Slide Sorter View Click on this button to see thumbnails of the slides.  
Double click on a slide to open it in the Slide Pane. 

 Slide Show View Click on this button to play the show starting with the 
slide that is currently selected. 

Slide Sorter View 
• To change the order of the slides, click and drag a slide to the new location. 
• OR Cut and Paste: 

o Right click on the slide to be moved and choose Cut. 
o Right click on the slide at the desired location and choose Paste. 

 The new slide will be pasted after the selected slide. 
• To change the size of the thumbnails, click on the down arrow of the Zoom box and choose the desired 

percentage. 

Viewing the Slide Show in Play Mode 
• On the Menu Bar, click on Slide Show  View Show or press F5 to play the slide show from the 

beginning. 
• To play the slide show from the current slide, click on the Slide Show button located at the 

bottom of the Slides and Outline pane. 

Tips and Tricks - Playing the Slide Show 
 

Keyboard Specials 

Action Keystroke Action Keystroke 

Previous Slide Left Arrow key or 
Page Up key 

Next Slide Right Arrow key, 
Spacebar key, Page 
Down key, or Enter 

Go to the first slide Home key Go to the last slide End key 

Stop the slide show Esc key   
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Using the Mouse 
• Left clicking on a slide advances to the next slide. 
• Right clicking on the slide brings up slide show options. 

Slide Show Options - Using Go 
Slide Navigator 

• Choose Go þ Slide Navigator. 
• Choose the desired slide from the list.  
• Click on the Go to button. 

By Title 
• Choose Go þ By Title. 
• Choose the desired title from the list. 

The Task Pane 
• The Task Pane offers help with documents, etc.  

Opening the Task Pane 
• On the Menu Bar, click on View þ Task Pane. 

Closing the Task Pane 
• Click on the X in the top corner of the Task Pane. 

Choosing a Task Pane 
• Click on the down arrow on the top right side of the Task Pane. 

o New Presentation- Blank Presentation, General Templates, etc. 
o Clipboard – Use to display the contents of the clipboard (up to 

24). 
o Search – Use to find documents of a specified name. 
o Insert Clip Art – Use to find and insert clipart. 
o Slide Layout – Use to select and apply a layout to a slide. 
o Slide Design - Design Templates – Use to select and apply a 

design template to selected slides or to all slides. 
o Slide Design - Color Schemes – Use to select and apply a color 

scheme to selected slides or to all slides. 
o Slide Design - Animation Schemes – Use to select and apply an 

animation scheme to selected slides or to all slides. 
o Custom Animation – Use to select and apply animation to objects on a slide. 
o Slide Transition – Use to select and apply a slide transition to selected slides or to all slides. 

Starting a Blank Presentation 
• On the Menu Bar, click on File þ New…. 
• In the New section of the Task Pane, click on Blank Presentation. 
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Applying a Design Template 
• On the Task Pane, click on the down arrow and choose Slide Design - Design 

Templates.  
• Rest your cursor over the desired template. 
• Click on the gray down arrow and choose Apply to All Slides or Apply to 

Selected Slides. 
• Note – Clicking on the template will automatically apply the design to all slides. 

Adding More Slides 

Using the Menu Bar  
• Click on the slide the new slide should follow. 
• On the Menu Bar, click on Insert þ New Slide.... 
• Click on the desired layout in the Task Pane. 

Using the Toolbar 
• Click on the slide that the new slide should follow. 
• On the Formatting toolbar, click on the New Slide button. 

Changing the Format of a Slide 
• Click on the slide to be changed. 
• On the Menu Bar, click on Format þ Slide Layout. 
• In the Task Pane, click on the desired layout. 

Entering Text 

Entering a Title 
• Click on the title/subtitle field on the slide. 
• Enter the text and press the Enter key. 

Entering Bullets 
• Click on the bullet text field. 
• Type the desired text. 
• Press the Enter key to move to the next bullet. 
• Press the Tab key to create sub-bullets OR click on the Increase Indent button on the Formatting toolbar. 
• To decrease the indentation, hold down the Shift key and press the Tab key OR click on the Decrease 

Indent button on the Formatting toolbar. 

Moving Text 
• Highlight the text. 
• Click on the Cut button on the toolbar. 
• Click where the text needs to be placed. 
• Click on the Paste button on the toolbar. 
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Copying Text 
• Highlight the text. 
• Click on the Copy button on the toolbar. 
• Click where the text needs to be placed. 
• Click on the Paste button. 

Spell Check 
• On the Menu Bar, click on Tools  Spelling. 
• Click on the Ignore button to leave the spelling of a word as it is. 
• To change the spelling of a word, choose the correct spelling from 

the list of Suggestions and click on the Change button. 
• Click on the Close button when finished. 

Saving the Slide Show 
• On the Menu Bar, click on File þ Save As... 
• Enter a title for the presentation. 
• Be sure to notice where you are saving the presentation. 
• Click on the Save button. 

Saving to a Previous Version 
• On the Menu Bar, click on File  Save As…. 
• Give the presentation a name. 
• Click on the down arrow at the end of the Save as type: box. 
• Choose the version of PowerPoint to be used. 
• Click on the Save button. 

Text Boxes 

Moving a Text Box 
• Click in the text box. 
• Move the cursor to the edge of the box. 
• Note - The cursor changes to a four-headed arrow. 
• Click and drag the box to the desired location. 

Resizing a Text Box 
• Click in the text box. 
• Move the cursor to a corner of the box.  (The box at the corner is called a handle.) 
• Note - The cursor changes to a two-headed arrow. 
• Click and drag to change the size of the box. 

Deleting a Text Box 
• Click in the text box. 
• Click on the border of the text box. 
• Press the Delete key on the keyboard. 
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Text Appearance 

Changing the Font and Font Attributes 
• Highlight the text. 
• From the Formatting toolbar, choose the font, font 

style, font size, or font color.  
o Note – The font size can also be changed by using 

the Increase Font Size and the Decrease Font 
Size buttons. 

• OR on the Menu Bar, click on Format þ Font and choose 
the font, font style, font size, or font color. 

• Click on OK. 
• Note - Some resizing of the font takes place automatically 

as more text is added to a slide. 

Changing Text Justification 
• Highlight the text. 
• Use the buttons on the Formatting Toolbar 
• OR on the Menu Bar, click on Format þ Alignment and choose the proper alignment. 

Changing the Text Color Using the Formatting Toolbar 
• Highlight the text to be changed. 
• On the Formatting toolbar, click on the down arrow beside the Font Color 

button. 
• Choose a color or click on More Colors to make a selection. 

Bulleted and Numbered Lists 

Turning Off Bullets 
• Highlight the desired text or click in the line of text. 
• Click on the Bullets button on the toolbar. 

Switching from Bullets to Numbering 
• Highlight the desired text or click in the line of text. 
• Click on the Numbering button on the toolbar. 

Turning Off Numbering 
• Highlight the desired text or click in the line of text. 
• Click on the Numbering button on the toolbar. 

Switching from Numbering to Bullets 
• Highlight the desired text or click in the line of text. 
• Click on the Bullets button on the toolbar.   
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Modifying Bulleted or Numbered Lists 
• Highlight the text.  
• On the Menu Bar, click on Format þ Bullets and Numbering 
• OR right click on the selected text and choose Bullets and Numbering.... 
• For bulleted text: 

o Click on the Bulleted tab. 
o Click on the desired type of bullets. 
o Choose Customize for more options. 
o Note - Choosing a different font will give other 

choices for bullets, (i.e. Wingdings, etc.) 
o Change the color of the bullet as desired. 
o Click on OK. 

• For numbered text: 
o Click on the Numbered tab. 
o Choose the desired type of numbering. 
o Change the color of the numbering as desired. 
o Click on OK. 

Changing Line Spacing 
• Highlight the text to be changed. 
• On the Menu Bar, click on Format þ Line Spacing...  
• Change the line spacing as desired. 
• Note - The Before paragraph and After paragraph sections separate bulleted 

items and paragraphs nicely. 
• Click on OK. 

Changing the Master Slide 
• Making changes to the Master Slide affects the entire presentation. 
• On the Menu Bar, click on View þ Master þ Slide Master. 
• The Slide Pane on the left displays the types of slides used in the presentation. 
• Click on the desired Slide Master. 
• Click on the parts of the slide that are to be changed and make the changes. 

o Changes might include the font style, font size, bullet symbols and colors, etc. 
• Click on the Close Master View button on the toolbar. 
• Note – Changes made before editing the Master Slide will not be affected. 

Modifying the Presentation 

Arranging the Slides 
• Change to the Slide Sorter View by clicking on the Slide Sorter button. 
• Click on the slide to be moved and drag it to the new location. 
• Note - As the slide is dragged to the new location, a vertical bar will show where the slide will go when the 

mouse button is released.  
• OR Cut and Paste: 

o Right click on the slide to be moved and choose Cut. 
o Right click on the slide at the desired location and choose Paste. 

 The new slide will be pasted after the selected slide. 
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Deleting a Slide 
• Change to the Slide Sorter View by clicking on the Slide Sorter button. 
• Click on the slide to be removed. 
• Press the Delete key. 

Adding Notes to a Slide 
• Click in the Notes Pane and add the desired information. 

Pictures 

Inserting a Picture from Clip Art 
• On the Menu Bar, click on Insert þ Picture þ Clip Art.... 
• Note - If prompted to Add clips to the organizer, click on Later. 
• Enter a subject in the Search text: box. 
• Click on the Search button. 
• Scroll through the list to find the desired clipart. 
• Click on the desired picture to add it to the slide. 
• Searching for a Different Picture 

o Click on the gray Modify button at the bottom of the clipart 
thumbnails. 

o Enter a new subject in the Search text: box and then click on the 
Search button. 

• Deleting a Picture 
o Click on the picture. 
o Press the Delete key. 

Inserting a Picture from Files 
• On the Menu Bar, click on Insert þ Picture þ From File.... 
• Navigate to the location of the picture, i.e. the My Pictures folder. 
• Click on the desired picture. 
• Click on the Insert button. 

Getting Pictures from the Internet 
• Find the picture on the Internet. 
• For a list of picture sites, go to http://www.davis.k12.ut.us/district/etc/cathy/clipart.html  
• Note - Be sure to read the Terms of Use on the site with the picture.  Don’t use it without permission. 
• Right click on the picture and choose Save Picture As.... 
• Navigate to where you are going to save the picture, i.e. the My Pictures folder. 
• Change the name of the picture if desired. 
• Click on Save. 

http://www.davis.k12.ut.us/district/etc/cathy/clipart.html
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Picture Toolbar 

 

Icon Icon Name Description 

 
Insert Picture Inserts a picture 

 
Image Control Allows the picture to be set to automatic (comes in original form), Grayscale, 

Black & White, or as a Watermark) 

 
More Contrast Click to increase the contrast of the picture. 

 Less Contrast Click to decrease the contrast of the picture. 

 
More Brightness Click to increase the brightness of the picture. 

 Less Brightness Click to decrease the brightness of the picture. 

 Crop Click to trim the sides of a picture. 

 
Rotate Left Click to rotate the picture to the left. 

 Line Style Click to choose a line border for the picture. 

 
Compress Pictures Click to prepare the picture for print or Web use. 

 
Recolor Picture Click to recolor portions of the picture. (Not available for all picture types.) 

 Format Picture Click to format the picture with a fill, border line, size, position, etc. 

 Set Transparent Color Click to set a color to be made transparent. 

 Reset Picture Click to set the picture back to the original. 

Moving a Picture 
• Click in the middle of the picture and drag it to the desired location. 
• Note – The cursor changes to a four-headed arrow. 

Resizing a Picture 
• Click on the picture to select it. 
• Move the cursor to a handle (circle) at the corner. 
• Note – The cursor changes to a double-headed arrow. 
• Click and drag towards the center of the picture to make it smaller OR away from the picture to make it 

larger. 

Rotating a Picture 
• Click on the picture. 
• Notice the green dot above the picture.  This is the rotation handle. 
• Click on the green dot and drag the picture to the desired angle. 
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Compressing Pictures 
• Note - Compressing pictures reduces the file size of the 

presentation, making it more manageable when moving it, sending 
it by email, etc. 

• Click on a picture.  
• Click on the Compress Picture button on the toolbar. 
• In the Apply to section, choose All pictures in document. 
• In the Change resolution section, choose Web/Screen. 
• In the Options section, make sure both options are checked. 
• Click on OK. 

Animating an Object (Text or Pictures) 
• Click on the object. 
• On the Menu Bar, click on Slide Show þ Custom Animation 
• OR right click on the object and choose Custom Animation. 
• Click on the Add Effect button in the Task Pane. 
• Choose Entrance, Emphasis, or Exit. 
• Choose from the available animations in the list. 
• Decide when the animation will happen by clicking on the down 

arrow after Start:. 
• Decide on the direction the action will go by clicking on the 

down arrow below Direction:. 
• Decide on the speed of the action by clicking on the down arrow 

below Speed:. 
• Note – A preview of the animation displays each time a choice is made. 

Removing/Changing the Animation 
• Click on the object. 
• Click on the corresponding number of the object in the animation list. 
• Click on the Remove button in the Custom Animation pane to remove the previous 

choice 
• OR click on the Change button to choose a different animation. 

Adding Multiple Animations to the Same Object 
• Click on the object. 
• Click on the Add Effect button in the Task Pane. 
• Choose Entrance, Emphasis, or Exit. 
• Choose from the available animations in the list. 

Changing the Order Objects Play 
• On the Menu Bar, click on Slide Show þ Custom Animation 
• OR right click on the object and choose Custom Animation. 
• Notice the list showing the order in which objects play. 
• Click on the object on the slide to be changed. (The animation in the list is highlighted.) 
• Click and drag the animation in the list to the desired playing position. 
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Slide Transitions 
• Click on the desired slide. 
• On the Menu Bar, click on Slide Show þ Slide Transition... 
• In the Task Pane, scroll through the transitions listed under Apply to 

selected slides. 
• Note - At the bottom of the list is Random Transitions. Useful for 

variety. 
• Adjust the speed of the transition by clicking on the down arrow after 

Speed:. 
• Add a sound by clicking on the down arrow after Sound:. 
• Control the advance of the slide by using the Advance slide section.   
• Choose either On mouse click, or set a time for the automatic advance 

of the slide. 
• Apply to all of the slides in the presentation by clicking on the Apply to 

All Slides button. 
 
 
 
 

Self-Running Show 
• Note – To have a self-running slide show, the slide 

transitions must be set to Automatically after with a 
desired length of time. 

• On the Menu Bar, click on Slide Show  Set Up the 
Show… 

• In the Show Options section, check the box to Loop 
continuously until “Esc”. 

• Click on OK. 
 
 
 
Sounds 

Adding an Automatic Sound to an Animated Object 
• Right click on the animated object the sound is to be attached to 

and choose Custom Animation. 
• In the Task Pane, click on the down arrow next to the animated 

object and choose Effect Options. 
• Click on the Effect tab.  
• In the Enhancements section, next to Sound, click on the down 

arrow and choose the desired sound. 
• Click OK. 
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Adding a Clickable Sound to an Object 
• Right click on the object the sound is to be attached to and choose 

Action Settings. 
• Check the box in front of Play sound. 
• Click on the down arrow in the box and choose the desired sound. 
• OR choose Other Sound… at the bottom of the list and navigate to 

the location of the sound. 
• Click OK. 
• Note – To hear the sound when playing the slide show, click on the 

object with the sound attached. 

Adding a Sound to a Slide Transition 
• On the Menu Bar, choose Slide Show  Slide Transition… 
• OR right click on the slide the sound is to be attached to and choose Slide Transition. 
• In the Task Pane, in the Modify Transition section, click on the down arrow next to sound and choose the 

desired sound. 

Printing 
• On the Menu Bar, click on File þ Print Preview. 
• Caution - Do not click on the Print button on the toolbar.  Clicking on the Print button sends the print job 

immediately to the printer without giving choices. 

Printing Options 
• Under Print what:, click on the down arrow and choose Slides, Handouts, 

Notes Pages, or Outline View. 
• When choosing Handouts, choose the number of slides to be printed on 

each page. 
o 2 per page places one at the top and one at the bottom. 
o 3 per page places the slides down the left side with lines for notes on the right. 
o 4, 6, or 9 per page places the desired number of slides on the page in a grid. 

• When choosing Notes Pages, the slides will be printed one per page with the slide at the top and the notes 
associated with the slide at the bottom. 

• When choosing Outline View, the printed copy will be an outline with no graphics. 

Printing 
• Click on the Print button at the top. 

Important Options 
• Frame Slides - At the bottom of the Print window, click on 

Frame slides.  Frame slides puts a wire frame around each slide 
as a border. 

• Printing Specific Slides - In the Print Range section, click on 
Slides.  Enter the numbers of the desired slides.  Numbers 
separated with commas print the specified pages.  Numbers 
separated with hyphens print the range specified. 
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